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INTRODUCTION 

PowerPoint is a presentation software program that allows you to create slides, handouts, notes 
and outlines that accompany an oral delivery of the topic.  It is widely used and is an effective 
tool.  This document provides instruction for creating a basic slide presentation using 
PowerPoint 2007 on your desktop Windows computer and includes best practices for making 
your presentation accessible.  

CREATE STRUCTURED DOCUMENTS  

The Microsoft suite provides support for addressing most accessibility issues that arise with 
electronic documents. In order to ensure that PowerPoint documents are ultimately accessible, 
content authors must utilize the formatting and layout options within Microsoft PowerPoint that 
support structural markup. This structural markup ensures that assistive technology software 
such as screen readers can correctly discern and interpret the structure of the PowerPoint 
presentation. 

BEST PRACTICE IN MICROSOFT OFFICE 

Best practices refer to a collection of how to's and what to avoid when authoring Microsoft Office 
documents and the ability to convert the document.  

• Following best practices will help you: 
o utilize the software more efficiently 
o simplify the conversion process 
o create structured documents 

 If in the original design and structure of the document, things are left out or are not done 
correctly, the final product will have missing information and display content incorrectly.   

Get into the habit of always following best practices. Create tables, charts, layouts, without 
using outside sources and you will actually save time while preparing a quality document.  

• Accessibility means that people with disabilities can use and access the document. 
More specifically, accessibility means that people with disabilities can perceive, 
understand, navigate, and interact with the document. 

The 
more structure that is added while authoring an office document before conversion the more 
accessible it will be after conversion.   

One of the advantages of true structure in Microsoft Office documents is that the file can be 
easily exported to a PDF document retaining necessary structure and will be accessible and 
compliant when posted on the web. Secondly, when exported to HTML structure will also be 
retained and with a few code tweaks your document will be accessible and compliant. In both 
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cases, the added structure increases the readability of the document for people using assistive 
technology. 

USING THEMES – WHY IT’S IMPORTANT 

In PowerPoint, the correct way to provide structure is to use the delivered PowerPoint themes.  
Many people do not use straight themes in PowerPoint. For example, when creating a slide, 
they simply change the font, enlarge the font size, make it bold, etc. If this is done, the 
document has no real structure that can be discerned by assistive technology users.  

Using Themes is an important element in giving your document true structure. 
PowerPoint 2007 has dedicated most of the Design tab ribbon to Themes (see Figure 1, below). 

Figure 1 – Design Tab, Themes Group 

 
 

 The Themes group contains theme “templates” that include color and font themes. 
Use these themes to create your slides.  
 

 Use the Colors, Fonts and Effects buttons to modify a given theme.  
 

 Themes can be changed at any time by selecting a different theme. However, this 
may require some re-working of the content on each slide. Each theme has its own 
font grouping and the size of the font could be different than what was initially in 
place.  

 
 Avoid changing color or fonts by highlighting a single line of text. All changes to fonts 

and color should be made at the Theme level so it will carry over to each slide 
seamlessly.  

 

Benefits of Using Themes: 

The use of Themes allows for formatting changes that can be made quickly and easily 

throughout the document without making changes to each individual slide. When the 

presentation is converted to another format, the use of Themes allows those changes to 

carry over as they were meant to be read. 
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THE NEW LOOK IN OFFICE 2007 

The Office 2007 suite of software, which includes Excel, Word, Access and PowerPoint, now 
has a very different look and feel. The traditional toolbars as we know them in previous versions 
have been replaced with what is now called a Ribbon. This section of the documentation will 
orient you to the new terminology used and where to locate the necessary elements.  

The PowerPoint Window in 2007 

The PowerPoint window (see Figure 3) is comprised of a slide and outline tabs, toolbars, and 
the ribbon. These are all used to create the presentation. The window also includes options for 
viewing the presentation as a slide show, or in an outline format. The Office button contains 
common file and system commands.  

POWERPOINT DEFINITIONS 

The PowerPoint environment is easier to learn if you understand the way that PowerPoint 
“thinks” about slides. The following definitions will help you with this.  

• Themes: Pre-defined backgrounds, which includes font and color themes. Themes set 
the mood for your presentation.  

• Views: Different ways to view your presentation. There are three views to choose from 
to view your presentation: 

o Normal View (Slide/Outline Default) 
o Slide Sorter View (Thumbnails) 
o Slide Show View (Presentation View) 

• Masters: Used to set the standard look and feel of the entire presentation by adding 
your own logo, special clip art, and the date and/or page numbers. For example, 
whatever is placed on the Master slide, will trickle down to each slide associated with 
that Master.  

• Layouts: Guides for each individual slide. Includes layouts for inserting graphs/charts, 
tables and clip art. New to 2007 is the ability to create your own slide layouts. This 
enables you to re-use complex layouts without having to manually create them each 
time.  

• Object: An object is anything that is in its own rectangular frame and can be sized, 
moved and formatted independently. This includes clip art, WordArt, pictures, audio, 
movies, graphs/charts and tables.  

• Animations: transitions and effects that control movement from one slide to another, 
i.e. fading in and out, etc. Animations control the content flow of each slide.  

• Output: Besides the electronic output and viewer, slides can be printed as overhead 
transparencies. Other print options include: 

o Handouts 
o Note Pages 
o Outline View 
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GETTING STARTED 

Launching Your PowerPoint Application: 

1. Click the Start button on the Taskbar at the bottom left corner of your Windows screen. 
2. Select All Programs. 
3. Click Microsoft Office from the submenu, and then select Microsoft Office 

PowerPoint 2007. 
4. The Normal View pane appears (see Figure 1, below). 

Figure 1 - Normal View Pane 

 
 

5. From the Normal View pane, click on the Office button and select New (see Figure 2). 

 
Figure 2 - New Presentation Task Pane 
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6. The New Presentation task pane contains a list of templates. For a new, blank 
presentation, select Blank and recent. 

Figure 3 - The PowerPoint Window 

                
 

1. Office Button: contains common file and system commands. 

2. Quick Access Toolbar: contains shortcuts for the most commonly used tools. 

3. Tab Bar: contains tabs that display tools and commands in the Ribbon.  

4. Ribbon: contains groups of tools and shortcuts for standard PowerPoint actions.  

5. Slides and Outline Tabs: displays slides as thumbnails or in a slide outline.  

6. Slide Pane: displays the selected slide.  

7. Notes Pane: displayed notes for the selected slide. This is also where notes are 

entered during the creation process.  

8. Status Bar: contains presentation information and view shortcuts.  
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Customizing the Quick Access Toolbar 

1. Click the Customize Quick Access Toolbar button (see Figure 1, below). 

Figure 1 - Customize Quick Access Toolbar Button 

 
 
 

2. A menu opens (see Figure 2, below). 

Figure 2 - Customize Quick Access Toolbar Menu 
 

 
 

3. Select More Commands from the menu.  
4. The PowerPoint Options dialog box opens (see Figure 3). 
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Figure 3 - PowerPoint Options Dialog Box 

 
 
 

5. Click the drop down menu in the Choose commands from field box and select a 
category from the resulting menu.  

6. In the left menu box, select the command you want to add and click the Add button. This 
will add the command to the right-hand menu box. These commands appear in the 
Quick Access Toolbar.  

7. To remove a command from the toolbar, select the command in the right-hand menu box 
and click the Remove button to remove it.  

8. Click the OK button when you are finished.  

Using the Ribbon 

The Ribbon contains command groups by task.  

Figure 1 - The Ribbon 
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• Tab: a tabbed page of the Ribbon.  
• Contextual Tabs: a tab that appears only when certain content is selected, such as a 

graphic or a chart.  
• Group: a section of a tab. The Home tab shown in the figure above has the following 

groups: Clipboard, Slides, Font, Paragraph, Drawing, and Editing. 
• Dialog Box Launcher: a small icon in the bottom-right corner of a group, from which 

you can open a dialog box related to that group.  

Note: to find out what a toolbar button does, position the mouse over it. A Screen Tip pops-up 
explaining its function.  

CREATING SLIDES: THEMES 

PowerPoint 2007 includes design elements called Themes. These elements include font and 
color themes that allow for unified formatting across the presentation. As mentioned in the Using 
Themes: Why It’s Important section, themes are used to give structure to your presentation and 
should always be used when creating a slide presentation.  

Selecting a Theme 

1. Click the Design tab (see Figure 1, below). 
2. Select a Theme from the Themes group by clicking on one of the themes. If the theme 

you want is not displayed, use the scrollbar to scroll through the available options.  
3. Once a theme is selected, the look and feel of the presentation will be consistent across 

all slides (see Figure 2, below). 

Figure 1 - Design Tab 
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Figure 2 - Example of a Presentation w/Theme 

 

CREATING SLIDES: CHANGING LAYOUTS 

Layouts are guides or placeholders for your content. Regardless of the theme selected, there is 
a placeholder for a title, text, clip art, etc.  

Layout Choices 

When a new presentation is created, the PowerPoint window opens with a pre-defined title slide 
(see Figure 1, next page). 

Note: these screen captures use the theme titled “Equity”. Your slides may different depending 
on the theme selected.  

Figure 1 - Title Slide 
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• To add text to a slide, single click on each section where noted and enter the desired 
text.  

• Text boxes can be moved or sized individually to accommodate your needs.  
• To select a different layout, click the Layout drop down menu, located under the Home 

tab and select a different layout from the list provided (see Figure 2). 

Figure 2 - Layout Drop-Down Menu Options 

 

Positioning or Resizing a Text Box 

1. Select the text box image by single clicking it. A gray, dashed-line border with small 
white boxes (handles) appears (see Figure 1). 
• To reposition a text box, single click the gray line border to make it “active”, next 

click the text box and drag it to the desired position.  
• To reposition an image, click the image and drag it to the desired position.  
• To resize a text box or image, single click the image or text box to make it active, 

next drag one of the handles to resize the text box or image.  
• To maintain the proportions of the text box or image, drag a corner handle as 

opposed to a side, top of bottom handle.  
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Figure 1 - Text Box/Image Handles 

 

Changing Bulleted Items 

Many of the slide layouts include bulleted items. Although pre-formatted, the bullet style can be 
changed at any time.  

1. Set your cursor on the line of the bullet you want to change (or highlight all of the bullets 
to change them at once). 

2. From the Paragraph grouping, click the Bullets drop-down menu.  
3. Select a bullet style from the dialog box (see Figure 2, below). 

Figure 2 - Bullets Dialog Box 
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WORKING WITH IMAGES 

Images are used in presentations for reference, emphasis, explanation, or aesthetics. It is best 
practice to use images that are representative of the content. Placement is also important. Place 
images where they will make sense when an adaptive screen reader is used.  

• It is best practice to left-align an image. This will be helpful when converting the 
document to HTML. Avoid placing images in tables.  

Adding Clip Art from the Ribbon 

Clip Art consists of ready-made illustrations, movies or sound clips that can be used to 
enhance a presentation. These clips are available from the application itself and if there is an 
internet connection established, many are available for download from the Microsoft Office site.  

To add a piece of clip art to a presentation: 

1. Select the slide you want to work with.  
2. Click the Insert tab on the Ribbon, then click the Clip Art button (see Figure 1). 
3. In the Clip Art task pane, enter a description for the type of clip you are searching for 

(cats, computers, trees, etc.) in the Search for field. 
4. In the Search in field, select All Collections from the drop-down menu.  
5. In the Results should be field, select the appropriate option from the drop-down menu.  
6. Click the Go button to view results.  
7. From the list of available options, select an image by clicking on it. This will place the 

image onto the slide. 
8. Move or resize the image as needed. This can be done the same way as moving or 

resizing a text box.  

Figure 1 - Adding Clip Art 
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Adding Clip Art to a New Slide 

PowerPoint 2007 also provides a short-cut option for adding Clip Art when creating a new 
slide.  

1. Click the New Slide button located on the Home tab (see Figure 1). 
2. With the new slide active, click on the Clip Art icon (see Figure 2). 

 
Figure 1 - Home Tab/New Slide Button 

 

 
Figure 2 - New Slide w/Clip Art Icon 

 
 

3. The Clip Art task pane opens. Enter the type of Clip Art you want to work with in the 
Search for field and click the Go button to retrieve the results.  
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Figure 3 - Clip Art Task Pane 

 
 

4. Click on the image you want to add it to the slide.  

Inserting a Picture from a File 

In addition to clip art, a picture can be inserted from a file. 

1. From the Insert tab, click the Picture button (see Figure 1, below).  

Figure 1 - Insert Tab / Picture Button 

 
 

2. The Insert Picture dialog box opens (see Figure 2, below). 
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Figure 2 - Insert Picture Dialog Box 

 
3. Find the file that you want to work with and then click on the Insert button to insert the 

photo into the presentation.  

IMAGE LABELING - ALT TEXT (TAGS)  

It is important that all images have a text description attached to it.  This allows for a description 
of an image when people do not have graphics enabled on their computers.  This description is 
called an Alt Text. 

The text supports the context of the document and/or conveys information to the user. Provide a 
short description of the image that briefly describes what the image is representing. If the 
example image was part of a technique for typing with one finger, a short description might 
read "One-finger typing technique with index finger" while the long description would include 
more details such as "The one-finger typing technique uses the index finger to strike keys while 
the remaining fingers and thumb are extended away from the keyboard." 

To enter a text description for an image: 

1. Right-click on the image 
2. The short cut menu appears (Figure 1) 
3. Click on  “Size and Position”  
4. The Size and Position dialog box appears (Figure 2) 
5. Click the Alt Text tab 
6. In the Alternative Text: field, enter the image description. 
7. Click the Close button. 
8. Use discretion in applying ALT tags.  ALT tags need to be descriptive and convey the 

meaning behind why the artwork or illustration has been included in the text.   They do 
not need to be lengthy.    
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Figure 1 - Size and Position Option Figure 2 – Size and Position Dialog Box, Alt Text Tab        

 
 

USING CHARTS AND DATA TABLES: 

Charts and Data Tables are visual ways of representing a group of data. A best practice for 
charts and data tables in Microsoft PowerPoint is to create the items within the document. 

Charts – Charts are recognized as images when converted to html.  A Chart will need to have 
information that describes the chart just like other images in your document.  

Tables - A table is a row and column matrix of cells that can contain text, images and other 
objects. While the main purpose of tables is to present data in a grid format, they can also be 
used to control the layout of content on a page.  

Creating & Editing Charts/Graphs: 

There are two specific elements used when making a chart or graph: 

• The chart itself, which is the graphical representation of your data. 
• The datasheet, which contains the actual statistics used to generate the graph.  

To create a new chart: 

1. From the Insert tab click Chart  
2. The Insert Chart dialog box appears (Figure 1, below) 
3. From the left-hand menu select the chart or graph option.  
4. From the right-hand display, select the chart type. 
5. Click OK 
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Figure 1 – Inserting a New Chart 

 
 

6. The chart and accompanying datasheet are displayed in a minimized, side-by-side 
format (see Figure 2, below). 
 

7. Select and delete the sample labels and data and then enter your own data into each 
cell.  
 
• Rows and Columns must have labels. This is important because it equates to items 

for the Axis and Legends of the chart.  
• You can also paste information from another source into a cell.  
• Information in the datasheet can be formatted for font, size, color, etc. from the 

Formatting toolbar. 
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Figure 2 – Chart/Graph and Datasheet 

 
 
Note: as the data is entered into the datasheet, the corresponding chart data will update 
automatically after you tab out of the cell.  

Inserting Tables: 

Good Accessibility Practices for Tables 

• Keep tables simple with minimal nesting  
• Avoid complex nested tables with multiple split and merged cells  
• Avoid splitting or merging cells after data has been entered, as this can confuse the 

reading order of the cells  
• Use percentage rather than pixels to set table and cell size. This will allow the table 

to resize gracefully  
• Keep heading labels short and descriptive. Use comments if they need longer 

explanations  
• Add descriptions before the table to provide information about the table  
• The reading order of tables is linear starting from the top left cell to the bottom right 

cell. The contents of each cell, including nested cells, are read before moving to the 
next cell. 

  



 

PowerPoint 2007 - Basics Page 19 
 

To create a table: 

1. From the Insert tab click Table (see Figure 1)  
 

2. Drag your mouse over the squares to designate the number of columns and rows to 
insert.  

3. Left-Click the mouse once designated. 

Note: As you move your cursor over the Insert Table dialog box to highlight rows and columns, 
the table will display in preview mode in the slide itself.  

Figure 1 – Inserting a table 

 
 

4. The table displays with an active border that includes “handles.” Use the handles to 
resize the table. The table can also be repositioned on the slide. 

5. To enter data into the cell, click within the cell to position the insertion point and then 
enter the data (see Figure 2, below). 

Figure 2 - Entering Data in the Table 

 
 
Note: Adjust the columns and rows by clicking on the area between them, and then dragging to 
the appropriate size.  

A new contextual tab named “Design” has also appeared on the Ribbon (see Figure 3). This is 
an on-demand tab and will appear any time the table is selected and active. Use the command 
elements on this tab to quickly format your table. 
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Figure 3 - On-Demand Design Tab 

 

DIFFERENT WAYS TO VIEW YOUR PRESENTATION 

There are three different ways to view your presentation. Each view is available by clicking the 
View buttons located at the lower right-hand corner of the PowerPoint application window (see 
Figure 1, below). 

1. Normal View (Outline) 
2. Slide Sorter View (Thumbnails) 
3. Slide Show View (Presentation) 

Figure 1 - View Buttons 

 

Normal View 

 

The Normal View is the default view and consists of three panes (see Figure 1, below). 

1. The left-pane displays either thumbnail images of the slides or a slide show outline, 
depending on the tab selected - Outline or Slide (default). 

2. The right pane displays the active slide.  
3. The bottom pane provides a place to enter notes about the slide.  
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Figure 1 - Normal View 

 

Slide Sorter View 

The Slide Sorter View displays all of the slides as thumbnails (see Figure 1). This view can be 
used to rearrange slides by drag-and-drop and it can also be used to set timing (automatic) and 
transitions (fade in, fade out, etc). 

Figure 1 - Slide Sorter View 

 
 

Slide Show View 

The Slide Show View shows how the presentation will look when projected onto a screen (see 
Figure 1).  

To navigate through the presentation while in Slide Show View: 

1. Use the spacebar or a mouse-click to advance. 
2. Use the Up/Down arrows on your keyboard to go forward and back.  
3. Use the Page Up/Page Down buttons to go forward and back.  
4. Use the ESC (escape) key on your keyboard to exit this view.  
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Figure 1 - Slide Show View 

 
 

WORKING WITH NOTES 

When presenting, you may find the addition of notes helpful to you. PowerPoint allows you to 
enter notes for each slide so when printed as Notes Pages, you will be able to view your notes 
as well as the slide they reference at the same time.  

Adding Notes To Your Presentation 

To add notes to your presentation: 

1. Click on the View tab in the Ribbon.  
2. Click on Notes Page (see Figure 1, below) 

Figure 1 - View Tab / Notes Page 

 
 

3. The Notes Page displays. The top half of the page is the active slide, the bottom half is 
where you enter your notes. Enter your notes as needed.  
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Figure 2 - Notes Page 

 
 

4. Use the scroll-bar on the right of the Notes Page to move forward and back through 
your slides as needed (see Figure 3, below). 

Figure 3 - Notes Page w/ Scroll Bar 
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Printing Note Pages 

Note Pages can be printed for presentation use: 

1. Click on the Office button.  
2. Click on Print (see Figure 1, below). 

Figure 1 - Office Button > Print 

 
 

3. In the Print dialog box, select Notes Pages from the Print what drop-down (see 
Figure 2, below). 

Figure 2 - Print Dialog Box 

 
4. Specify the number of copies and then click the OK button.  
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POWERPOINT FINAL TOUCHES 

Enter Additional Presentation Properties Information: 

Microsoft PowerPoint allows you to insert summary information about the presentation such as 
author name, date created, and comments. This is entered on the PROPERTIES box. 

To access PROPERTIES: 

1. From the Office Button, Select Prepare (see Figure 1). 
2. From the submenu click on Properties. 

Figure 1 – Office Button Options (Prepare & Properties) 

 

3. The Document Properties box is displayed just below the Ribbon. (see Figure 2). 

Figure 2 – Document Properties Box 

 

4. Complete the appropriate fields such as, Author, Title, and Subject. 
5. Click the “X” to close the window (see Figure 2, above).  
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Saving Your Document: 

To save your presentation: 

1. From the Office button, select Save As (see Figure 1). 
2. Click on either: 

a. PowerPoint Presentation to save as a PowerPoint 2007 presentation. 
b. PowerPoint 97-2003 Presentation to save as a 97-2003 presentation. This is 

important if you plan to use it on a computer that is not running 2007.  

 
Figure 1 – Office Button menu – Save As 

 
 
 

3. The Save As dialog box appears.  
4. Complete the Save In and File Name fields.  
5. Click the Save button.  

Saving Your Presentation as a PDF File 

Saving a document as a PDF is a great way to save the content and formatting of a document 
so that when others want to print the document it maintains its integrity.  If you will be posting 
the PDF document to a website it is recommended that you state that the PDF document link is 
a “printer friendly” version.  It is not recommended that the PDF document be used as an 
accessible document.  
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If you have Adobe Acrobat Professional 

1. From the Office button, select Save As (see Figure 1). 
2. Click Adobe PDF from the right-hand menu. 

 

Figure 1 – Office Button, Save As > Adobe PDF 

 
 

1. The Acrobat PDF Maker warning window displays (see Figure 2). 

Figure 2 - The Acrobat PDF Warning Window 

 
 

2. Click the Yes button. 
3. The Save Adobe PDF File As window displays (see Figure 3). 
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Figure 3 - Save Adobe PDF File As Window 

 
 

4. In the Save in and File name fields, fill in the appropriate information. 
5. Click the Save button. 
6. An Adobe processing window appears and displays the progress of the conversion (see 

Figure 4).  

Figure 4 - Adobe Processing Window 

 
 

7. Once processed, the PowerPoint presentation will open in Adobe Acrobat as a PDF file 
(see Figure 5). 

Figure 5 - Presentation Displays in Adobe Acrobat Professional as a PDF File
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Saving a document as a PDF is a great way to save the content and formatting of a document 
so that when others want to print the document it maintains its integrity.  If you will be posting 
the PDF document to a website it is recommended that you state that the PDF document link is 
a “printer friendly” version.  It is not recommended that the PDF document be used as an 
accessible document.  

If you DO NOT
 

 have Adobe Acrobat Professional 

1. For Office 2007 users –  
a. Download the FREE plug-in from Microsoft.com that will allow you to export 

and save to the PDF format.  
b. http://www.microsoft.com/downloads/details.aspx?FamilyId=F1FC413C-6D89-

4F15-991B-63B07BA5F2E5&displaylang=en    
c. You can also us Internet Explorer and Google “Microsoft Save as PDF” and the 

link should come up as well. 
d. Once at the Microsoft Download Center click the Download button and follow 

the instructions. 
2. For Office 2003 users – There is no plug-in from Microsoft.  You must buy Adobe 

Acrobat. 

3. Once Plug-in is downloaded and installed, Click the Microsoft Office Button in your 

Word document, Select Save As (See Figure 6) 

4. Click PDF or XPS from the right-hand menu. 

Figure 6 - Office Button, Save As > PDF or XPS 

 
 

http://www.microsoft.com/downloads/details.aspx?FamilyId=F1FC413C-6D89-4F15-991B-63B07BA5F2E5&displaylang=en�
http://www.microsoft.com/downloads/details.aspx?FamilyId=F1FC413C-6D89-4F15-991B-63B07BA5F2E5&displaylang=en�
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5. Complete the Save in and File name fields.  
6. Click the Publish button. 
7. Once processed, the presentation will open in Adobe Acrobat Reader as a PDF file.  
8. To perform a quick Accessibility check of your PDF document, click on the 

Documents menu and select Accessibility Quick Check.  (see Figure 7) 

Figure 7 – Perform an Accessibility Quick check on your PDF Document 

 

Saving Your Presentation in HTML 

To save your PowerPoint presentation as HTML to publish to a website: 

1. From the Office button, select Save As. 
2. From the right-hand menu, click Other Formats.  
3. The Save As dialog window displays (see Figure 1). 
4. Give the file a name and select the appropriate file location. 
5. In the Save as type field, use the drop-down arrow and scroll bar to show and select 

the Web Page option. 
6. Click the Save button. 

Figure 1 - Save As Dialog Window 
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QUICK TIPS TO ACCESSIBLE PRESENTATIONS  

PowerPoint is a presentation tool, but if the presentation is posted on the web, then it is 
important to keep these tips in mind: 

• Place content in logical reading order. This is fundamental to creating accessible 
documents.  

• Do not use TAB, Spacebar and Enter keys to format for tables, columns, lists etc.  
• Use the application's built-in features to encode semantic structure (headings, paragraphs, 

lists, sections, headers/footers, tables, columns, forms etc.).  
• Define and use themes to format structural elements like headings, paragraphs etc. to 

control typography and layout.  
• Use standard fonts. Do not use fonts that do not map to Unicode.  
• Avoid complex layout, sidebars and other ornamentation as they make it difficult to maintain 

a logical reading order.  
• Avoid placing content in drawing-canvases or text-boxes as these are floating objects and 

flow to the bottom of a page's reading-order.  
• Group multiple graphic elements (created by drawing tools, charts etc) into one image.  
• Provide alternative text descriptors for all non-textual elements (graphs, images, illustration, 

pictures, multimedia, etc) that provide essential information.  
• Ensure that all navigation and interactivity can be performed using the keyboard. 

 

OTHER RESOURCES OR TRAINING 

1. Microsoft Online – Create an accessible Office document 
http://office.microsoft.com/training/training.aspx?AssetID=RC063800961033 

 
2. College ATI coordinators. Each college has an ATI coordinator ready to help and 

assist you. To find out your coordinator go to:   

 
http://www.csun.edu/accessibility/aticoordinators.html 

3. The Accessible Technology Initiative (ATI) Office can assist you with questions or 
information pertaining to accessibility.  Their 
website: http://www.csun.edu/accessibility/ has many tools, references, FAQ’s, 
accessibility training and a listing of the collage ATI coordinators to assist you.   

  

 
This manual is an introduction to accessibility coding in Microsoft Office 2007 and Adobe 
Acrobat 8.0.  Any further questions can be answered by consulting Microsoft Office and Adobe 
Help documentation.  
 

http://office.microsoft.com/training/training.aspx?AssetID=RC063800961033�
http://www.csun.edu/accessibility/�


 

V4 11-209                                                PowerPoint 2007 - Basics 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

IT’s technology training guides are the property of California State University, Northridge. They are 
intended for non-profit educational use only. Please do not use this material without citing the source. 
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